Fusion of short-mid wavelength infrared image and long wavelength image using discrete wavelet transform for image quality enhancement

Rocky Hedrick
University of Arkansas, Fayetteville

Follow this and additional works at: http://scholarworks.uark.edu/eleguht
Part of the Electromagnetics and Photonics Commons, and the Manufacturing Commons

Recommended Citation
Hedrick, Rocky, "Fusion of short-mid wavelength infrared image and long wavelength image using discrete wavelet transform for image quality enhancement" (2015). Electrical Engineering Undergraduate Honors Theses. 34.
http://scholarworks.uark.edu/eleguht/34

This Thesis is brought to you for free and open access by the Electrical Engineering at ScholarWorks@UARK. It has been accepted for inclusion in Electrical Engineering Undergraduate Honors Theses by an authorized administrator of ScholarWorks@UARK. For more information, please contact scholar@uark.edu, ccmiddle@uark.edu.
FUSION OF SHORT-MID WAVELENGTH INFRARED IMAGE AND LONG WAVELENGTH IMAGE USING DISCRETE WAVELET TRANSFORM FOR IMAGE QUALITY ENHANCEMENT
FUSION OF SHORT-MID WAVELENGTH INFRARED IMAGE AND LONG WAVELENGTH IMAGE USING DISCRETE WAVELET TRANSFORM FOR IMAGE QUALITY ENHANCEMENT

An Undergraduate Honors College Thesis

in the

Department of Electrical Engineering
College of Engineering
University of Arkansas
Fayetteville, AR

By

Rocky Hedrick
This thesis is approved.

Thesis Directors:

Baohua Li

Dr. Shui-Qing (Fisher) Yu
ABSTRACT

Infrared technology advancements have led to an expansive set of infrared applications in both the private and public sectors. New materials and manufacturing techniques have continued to reduce the cost while improving the quality of infrared cameras, but the cost is still high when compared to the cost versus quality of visible light spectrum cameras. Innovative image processing techniques can be implemented to help bridge this gap between the cost and quality of infrared cameras. The goal of this research is to improve the overall quality of infrared imaging by fusing short-mid wavelength infrared images and long wavelength images of the same background and objects. To achieve this goal, infrared camera theory as well as image fusion theory will be first introduced to provide adequate background knowledge. Then, the setup of the experiment and calibration of the two infrared cameras will be described in details. Next, the image registration and fusion procedures will be presented by Matlab software. The results of this research show that the fused images have higher quality than individual short-mid wavelength infrared images and/or long wavelength images.
ACKNOWLEDGEMENTS

I thank Dr. Li and Dr. Yu for their continued guidance and support in the past two semesters during the course of my research. They have pushed me to achieve my best in pursuit of my honors degree. I also thank Mr. Seyed Amir Ghetmiri for his assistance with the setup of the conducted experiments. Lastly, I thank my family and classmates for supporting me over the last four years during my time in the electrical engineering program.
# TABLE OF CONTENTS

1. INTRODUCTION ............................................................................................................................. 1
   1.1 Problem: Inadequate Infrared Image Quality with Low Cost Cameras ................................. 1
   1.2 Thesis Statement .......................................................................................................................... 2
   1.3 Approach .................................................................................................................................... 2
   1.4 Potential Impact ......................................................................................................................... 3
   1.5 Organization of Thesis .............................................................................................................. 3
2. BACKGROUND .................................................................................................................................. 4
   2.1 Infrared Detector Theory ......................................................................................................... 4
   2.2 Discrete Wavelet Transform Based Image Fusion Theory ....................................................... 5
3. PHYSICAL EXPERIMENT ............................................................................................................... 9
   3.1 Infrared Camera Core Specifications ....................................................................................... 9
   3.2 Infrared Camera Core Software/Calibration ............................................................................ 11
   3.3 Infrared Camera Core Setup .................................................................................................... 17
   3.4 Acquired Sets of Images .......................................................................................................... 18
4. DWT BASED FUSION OF THREE SETS OF INFRARED IMAGES ......................................... 24
   4.1 Registration and Fusion of Image Set #1 ................................................................................. 24
   4.2 Registration and Fusion of Image Set #2 ................................................................................. 27
   4.3 Registration and Fusion of Image Set #3 ................................................................................. 28
5. CONCLUSION ................................................................................................................................. 30

REFERENCES ....................................................................................................................................... 31

APPENDIX ............................................................................................................................................. 32
   A. MATLAB Source Code – DWT Algorithm ............................................................................. 32
   B. MATLAB Source Code – Control Point Mapping Registration ............................................ 35
   C. MATLAB Source Code – PCA Algorithm ................................................................................ 36
   D. MATLAB Wavelet Toolbox – Image Fusion GUI ................................................................. 37
LIST OF FIGURES

Figure 2.1. Two-Dimensional DWT Implementation................................................................. 7
Figure 3.1. NIT MATRIX 1024 CORE-S [6]............................................................................ 9
Figure 3.2. FLIR Tau 2 [7]....................................................................................................... 10
Figure 3.3. NIT Acquisition Software – Home Screen............................................................. 11
Figure 3.4. NIT Acquisition Software - Calibration and Data Logging Features....................... 12
Figure 3.5. NIT Visualization Software - Home Page............................................................... 13
Figure 3.6. NIT Visualization Software - Playback Feature.................................................... 14
Figure 3.7. FLIR GUI – Camera Connection ............................................................................. 15
Figure 3.8. FLIR GUI - Home Page ......................................................................................... 15
Figure 3.9. FLIR GUI - Image Capture ...................................................................................... 16
Figure 3.10. Experiment Setup ................................................................................................. 18
Figure 3.11. Image Set #1 - Visible Light Image .................................................................... 19
Figure 3.12. Image Set #1 – LWIR Image ................................................................................. 19
Figure 3.13. Image Set #1 – SMWIR Image ............................................................................. 20
Figure 3.14. Image Set #2 – Visible Light Image .................................................................... 20
Figure 3.15. Image Set #2 – LWIR Image ................................................................................ 21
Figure 3.16. Image Set #2 – SMWIR Image ............................................................................ 21
Figure 3.17. Image Set #3 – Visible Light Image .................................................................... 22
Figure 3.18. Image Set #3 - LWIR Image ................................................................................ 22
Figure 3.19. Image Set #3 - SMWIR Image ............................................................................ 23
Figure 4.1. Image Set #1 – Visible Light Image ..................................................................... 26
Figure 4.2. Image Set #1 - LWIR Image After Registration ...................................................... 26
Figure 4.3. Image Set #1 – SMWIR Image After Registration ................................................... 26
Figure 4.4. Image Set #1 – Fused IR Image ............................................................................. 26
Figure 4.5. Image Set #1 – Fused IR Image by Matlab GUI ..................................................... 26
Figure 4.6. Image Set #2 – Visible Light Image ..................................................................... 28
Figure 4.7. Image Set #2 - LWIR Image After Registration ..................................................... 28
Figure 4.8. Image Set #2 – SMWIR Image After Registration .................................................. 28
Figure 4.9. Image Set #2 – Fused IR Image by Matlab GUI ..................................................... 28
Figure 4.10. Image Set #3 – Visible Light Image .................................................................... 29
Figure 4.11. Image Set #3 - LWIR Image After Registration .................................................... 29
Figure 4.12. Image Set #3 – SMWIR Image After Registration ................................................ 29
Figure 4.13. Image Set #3 – Fused IR Image by Matlab GUI .................................................... 29
LIST OF EQUATIONS

Equation 2.1 ......................................................................................................................6
Equation 2.2 ......................................................................................................................6
Equation 3.1 ......................................................................................................................12
Equation 4.1 ......................................................................................................................24
1. INTRODUCTION

1.1 Problem: Inadequate Infrared Image Quality with Low Cost Cameras

Continued advancements in infrared technologies have opened the door for a variety of infrared imaging applications. For example, in military and defense, infrared imaging can be used for portable weapon systems and smart munitions [1]; in industry it can be used for quality inspections, process control, and equipment inspections [1]; in personal life, it can be used for smart cars and smart homes. New manufacturing techniques have been reducing the cost of infrared cameras and improving the image quality. However, to meet the requirements of emerging infrared applications, it is necessary to reduce camera cost and improve image quality further.

Dr. Fisher Yu’s group at the University of Arkansas has been developing innovative technologies to make Silicon Germanium Tin (SiGeSn) based short and mid wavelength infrared cameras at an even lower cost than comparable ones in the current market while simultaneously increasing the image quality.

Instead of purchasing a more expensive camera or changing the manufacturing techniques, another way to obtain better infrared images is to incorporate image fusion methods. Image fusion has been developed and applied to image sets focused on different objects in the frame to enhance the overall image quality. It has also been applied to multispectral images across the visible and infrared spectrums to provide a higher-quality image output.

Using the advantages of new infrared camera manufacturing technology and an image fusion method, a multispectral infrared camera system is proposed as follows: (1) SiGeSn based IR detectors are used for short and mid wavelength infrared image; (2) Low cost microbolometers are used for long wavelength infrared image; (3) These two types of detectors are
integrated to create the new multispectral infrared camera; (4) Image fusion methods are used in this new camera to integrate multispectral images. Therefore, such a new camera with multispectral detectors and image fusion will be able to balance the cost and the quality of infrared imaging. In this thesis, the proposed multispectral infrared camera system will be mimicked. More specifically, discrete wavelet transform (DWT) based image fusion will be applied to efficiently integrate short-mid wavelength infrared images from a low cost Lead Selenide (PbSe) based camera and long wavelength infrared image from a micro-bolometer camera of the same scenario to form a higher quality single composite image which is more informative and more suitable to the scenario than both individual images for visual perception and computer processing.

1.2 Thesis Statement

The goal of this honors thesis research is to utilize two infrared camera cores which cover short, mid, and long infrared spectrum ranges and DWT based image fusion to improve the overall image quality of the camera output. This research will also serve to support the vision of Dr. Fisher Yu’s group and prove the value and potential application for developing low cost and high quality short and mid wavelength infrared cameras.

1.3 Approach

One long wavelength infrared (LWIR) camera core and one short-mid wavelength infrared (SMWIR) camera core will be used during the experiments to obtain two infrared images of the same scenario. The LWIR camera core is a FLIR product, and the SMWIR camera core is a NIT product. Once appropriate image sets of the same scenario are obtained from both cameras, Matlab will be used to perform image registration. Then, the DWT image fusion method will be applied to the infrared image sets to obtain a higher quality output.
1.4 Potential Impact

By applying multispectral infrared image fusion on image sets obtained from current market infrared camera cores, the image quality of the individual cores can be improved. The full potential of each camera core can be maximized by coupling the camera image outputs with additional image registration and processing within Matlab. The research performed in this thesis not only provides a way to increase image quality of current infrared technologies, but it also proves the practicality of the proposed low cost and high quality multispectral infrared camera system as pertains to the goal of Dr. Fisher Yu’s group for developing SiGeSn based infrared detectors.

1.5 Organization of Thesis

This thesis is comprised of five sections. The first section provides the problem statement, approach, and potential impact of the proposed thesis statement. The second section addresses the infrared technology and image fusion theory required to fully understand the approach to the thesis problem. The third section outlines the procedures established to setup the infrared camera cores and obtain the desired image sets. The fourth section provides extensive details and results of the image registration, processing techniques, and fusion methods using Matlab toolboxes. Finally, the fifth section addresses the conclusions drawn as result of the research performed.
2. BACKGROUND

2.1 Infrared Detector Theory

Infrared radiation occurs on a specific section of the electromagnetic spectrum, typically ranging from 1µm to 1mm wavelengths. The infrared spectrum can be further subdivided; and for the purpose of this research, short-mid wavelength infrared (SMWIR), 1µm to 8µm, and long wavelength infrared (LWIR), 8µm to 15µm, will be further analyzed. Infrared radiation can be measured by utilizing infrared detectors. Infrared detectors are classified into two primary groups based on the specific mode of operation and infrared wavelength to be measured.

The first group of infrared detectors is thermal detectors. Thermal detectors operate by allowing the infrared radiation to heat up the material of which the detector is manufactured. The temperature difference across the material from the background is converted to an electrical signal that can be read and processed by accompanied electronics. A bolometer is an example of a specific type of thermal detector that measures and converts the temperature difference on the material to a difference in electrical resistance to achieve an output signal. The signal from thermal detectors is largely dependent on the power of the infrared radiation received and the associated rate of change of the infrared energy. Thermal detector based cameras are used to measure long wavelength infrared radiation. Thermal detectors are relatively inexpensive but have moderate sensitivity and a potentially sluggish response [2].

The second group of infrared detectors is photon detectors. Instead of infrared radiation heating up the detector material as in thermal detectors, photon detectors capture the infrared radiation in the detector material through electron interaction. The infrared radiation excites the electrons and alters the energy dispersion throughout the material. The electrical signal produced as a result of the altered energy distribution can be examined and processed by accompanied
electronic systems. Photon detectors have faster response times and higher sensitivity than thermal detectors. Infrared cameras made of photon detectors that dominant at the current market are used to measure short and mid infrared wavelength radiation. However, these photon detectors may be more expensive than thermal detectors and may require expensive cooling techniques for reducing thermal noise to have sufficiently good performance [2]. New SiGeSn based photon detectors have great potential to overcome these disadvantages. The current dominant technology used in the integrated circuit industry, a complementary metal-oxide-semiconductor (CMOS) compatible process, can be used to build the SiGeSn infrared detectors and could eventually lead to large scale manufacturing with extremely low associated costs. The reduction of the fabrication cost will not lead to lower device performance. SiGeSn based infrared detectors have high detectivity to obtain even single photon level of detection without requiring any cooling mechanisms.

2.2 Discrete Wavelet Transform Based Image Fusion Theory

The discrete wavelet transform (DWT) is a wavelet transform applied to a given signal at a discrete sampling rate as the name implies. DWT implements a series of filters to expand the signal. In order to be utilized for the purpose of image fusion, the DWT must be employed in a two-dimensional manner. Two-dimensional DWT is achieved by first applying a low pass and high pass filter to the rows of the original image. Equations 2.1 and 2.2 demonstrate the wavelet coefficient outputs of the low pass filters, $a_{lp}[p]$, and high pass filters, $a_{hp}[p]$, respectively. The coefficients of the low pass filters are denoted by $l[n]$, and high pass filters are denoted by $h[n]$. The original signal to which DWT is applied is represented by $x[n]$ [3].
\[ a_{lp}[p] = \sum_{n=-\infty}^{+\infty} l[n-2p]x[n] \quad (2.1) \]

\[ a_{hp}[p] = \sum_{n=-\infty}^{+\infty} h[n-2p]x[n] \quad (2.2) \]

The result of applying the filters to the rows of the original image produces two separate images. Next, a low pass and high pass filter are applied to the columns of each of the two images produced from the first step. The final result yields a total of four images, or sub bands. The sub-bands are labeled according to the order in which the filters were applied. For example, the sub-band in which a low pass filter was applied to the rows and a high pass filter applied to the columns is labeled the LH sub-band. The LL sub band is considered the approximation band since the high frequency components of the signal are filtered out. The result of the LL sub-band is a lower quality version of the original image. The LH, HL, and HH sub-bands are considered the detail bands of the original image. The LH sub-band emphasizes the vertical edges of the image by filtering out the high frequency components across the rows. The HL sub-band emphasizes the horizontal edges of the image by filtering out the high frequency components across the columns, and the HH sub-band emphasizes the horizontal edges of the image. The process may be repeated by starting with the LL sub-band to produce four new sub-bands. The level of decomposition increases each time the process is repeated. Figure 2.1 illustrates a single level decomposition of a two-dimensional DWT implementation [4].
Two-dimensional DWT is the first step of DWT based image fusion. Once DWT has been applied to the two images to be fused, the four sub-bands will be generated for each image. The LL sub-band coefficients of each image are averaged to produce the LL sub-band of the fused image. The detail sub-bands of the images are subdivided into smaller windows. The sum total of the absolute values of the pixels in the smaller windows is compared to the corresponding windows between the sub-bands of each image. Decision maps are generated according to which image’s sub-band holds the higher value within each of the windows. The resulting sub-bands for the fused image pull the details from each image that provide the most
amount of information, which corresponds to the sum total of the absolute values of the pixels. When the LL, LH, HL, and HH sub-bands of the fused image are established, inverse DWT is applied to generate the fused image [5]. In addition, such DWT and Inverse DWT methods for infrared image fusion have been shown by Matlab program in Appendix A.
3. PHYSICAL EXPERIMENT

3.1 Infrared Camera Core Specifications

Two different infrared camera cores are used in the process of the experiment to obtain sets of images. The short-mid wavelength infrared (SMWIR) camera core is the MATRIX 1024 CORE-S manufactured by New Infrared Technologies (NIT) based out of Madrid, Spain. The MATRIX 1024 CORE-S is an uncooled, 32 x 32 focal plane array (FPA) comprised of vapor phase deposited (VPD) PbSe with a detection band ranging from 1µm to 5µm IR wavelengths. The camera is capable of producing 100 frames per second and has a direct USB connection. Additional metallic housing and a 7.6 degree, 24 mm WFOV lens were purchased for the camera. The MATRIX 1024 CORE-S is pictured below without the attached lens and housing in Figure 3.1.

![Figure 3.1. NIT MATRIX 1024 CORE-S](image)
The long-wavelength infrared (LWIR) camera core is the Tau 2 manufactured by FLIR. The Tau 2 is another uncooled core that utilizes a micro-bolometer instead of the photon detectors used in the NIT MATRIX 1024 CORE-S. The FLIR Tau 2 is a 160 x 128 FPA with a detection band ranging from 7.5µm to 13.5µm IR wavelengths and comes pre-packaged with a metallic housing and desired lens. A 9mm WVOF lens was installed on the Tau 2 used in this experiment. The FLIR Tau 2 is pictured below in Figure 3.2.

Figure 3.2. FLIR Tau 2 [7]
3.2 Infrared Camera Core Software/Calibration

The NIT MATRIX 1024 CORE-S is accompanied by a software suite that allows users to store, visualize, and analyze data capture by the camera core via the USB connection. Once the software package and appropriate USB driver is installed, the MATRIX 1024 acquisition program should be opened. Communication ports do not need to be specified if the software and drivers are properly installed. Successful camera connection can be verified in the bottom right hand corner of the software window. Figure 3.3 displays the home screen of the acquisition software. First, the camera core settings must be properly adjusted. Integration time and reset time are adjusted to change the frame rate of the camera. The desired frame rate can be used with Equation 3.1 below to calculate the new values of the camera core parameters. For this experiment, only individual frames were used for analysis purposes so the frame rate setting was insignificant, but for future experiments involving video analysis, this equation may be used to establish a proper frame rate.

Figure 3.3. NIT Acquisition Software – Home Screen
The output file of the MATRIX 1024 CORE-S is saved through the acquisition software in the form of a .DAT file. The file location for the .DAT file must be specified by pressing the “Start Data Logging” button as seen in Figure 3.4. The next step in effectively capturing high quality data is to calibrate the camera. As the camera is acquiring data, an object of uniform temperature should be placed directly in front of the camera lens. The “Internal Calibration” button featured in Figure 3.4 should be selected. The object should be held in front of the lens until the calibration is complete. Remove the object to begin capturing the desired images with a properly calibrated MATRIX 1024 CORE-S.

![Figure 3.4. NIT Acquisition Software - Calibration and Data Logging Features](image-url)
The MATRIX 1024 CORE-S visualization software allows users to analyze the data files recorded using the acquisition software. Upon starting the software, the desired .DAT file should be opened from the home page seen in Figure 3.5 by selecting “File→Open”. The visualization software contains several different features, but the primary feature utilized in this experiment is the playback feature, which allows the recorded video in the .DAT file to be viewed and individual frames to be exported as a .BMP (bitmap) file. Figure 3.6 displays the tab and settings used to grab the individual frame required to be used in the image fusion steps.

![Figure 3.5. NIT Visualization Software - Home Page](image-url)
The FLIR Tau 2 is accompanied by a camera controller GUI that allows users to record data in a video format or as individual frames. The VPC module must be used as an additional attachment to the Tau 2 to provide the USB connection required to communicate with the FLIR GUI. Once the software and USB drivers are installed and the camera is connected, the communication port must be established properly as seen in Figure 3.7. The window in Figure 3.7 is accessed by selecting “Tools → Connection.” Select Serial (RS-232), set the baud rate to 921600, and select “Finish” to connect the camera. The home page of the GUI will display a green LED and read “Connected” if the connection is successful. The part number and serial number of the camera will also be displayed as seen in Figure 3.8.
Figure 3.7. FLIR GUI – Camera Connection

Figure 3.8. FLIR GUI - Home Page
Click the “Video” icon on the left hand side of the window followed by selecting the “Image Capture” tab to access the ability to capture, display, and save individual images. The “Take Snapshot” button is used to capture the image. The image is saved in the on-board memory of the Tau 2. The model used in this experiment can store approximately 100 8-bit snapshots. The “Manage Snapshots” is used to display captured images in addition to saving the desired images onto the computer or other external memory source. Figure 3.9 indicates the locations of the buttons used to access the functionalities addressed above.

![Figure 3.9. FLIR GUI - Image Capture](image-url)
3.3 Infrared Camera Core Setup

Due to the nature of the functionality of a SMWIR camera core composed of photon detectors, the design and setup of this experiment had to be carefully planned. The MATRIX 1024 CORE-S is a low resolution core that only registers objects which emit a large amount of SMWIR light. In order to test that core was properly registering images, a lighter was held in front of the lens of the camera. The flame tip of a lighter emits SMWIR light and should register in the images saved by the MATRIX 1024 CORE-S. Originally, the experiment was designed around the premise that the SMWIR core would be sensitive enough to register objects on which concentrated IR light was placed. The reflection of SMWIR light off of the objects in frame was not strong enough to be recorded by the MATRIX 1024 CORE-S. The focus of the experiment design was turned towards objects that radiate a large amount of heat which translates to a high emission of SMWIR light. The tip of a soldering iron was considered as a potential object to record, but the object’s dimensions were not complex enough to provide a good test set of images.

The final design of the experiment involved the use of stainless steel nuts and bolts placed onto a VWR hotplate to create a test set of images to use during image fusion. The experiment was performed on an optical table. The MATRIX 1024 CORE-S and Tau 2 were mounted on optical posts at 90 degrees to provide a top-down view of the objects to be captured. A bubble level was used to ensure that both cameras were pointed directly down. The height of each camera was adjusted so that the objects were completely in the image frame, then the lenses were focused. Since the images from both cameras will not align naturally for the image fusion process, a square metal frame was placed around the target objects to provide a reference point to be used during the image registration process. Figure 3.10 displays the experiment setup.
3.4 Acquired Sets of Images

Three different sets of images were obtained using the experiment setup as previously described. For the first set, the VWR hotplate was set to the medium-high temperature setting (approximately 300°C), and the target object was a stainless steel nut attached to a bolt. The object was placed onto the hotplate, and the images were taken immediately to prevent the object from being heated to the hotplate temperature. Figure 3.11 shows the top-down image of the object taken by a visible light camera to provide a reference to the infrared images. Figure 3.12
displays the LWIR image taken by the Tau 2. Figure 3.13 displays the SMWIR image taken by the MATRIX 1024 CORE-S.

Figure 3.11. Image Set #1 - Visible Light Image

Figure 3.12. Image Set #1 – LWIR Image
The second set of images was taken with the VWR hotplate set to the high temperature setting (approximately 400°C), and the target objects are two stainless steel nuts placed side-by-side. The target objects were placed on the hotplate and allowed to heat up for approximately 20 minutes before the images were taken. Figure 3.14 shows the top-down image of the object taken by a visible light camera to provide a reference to the infrared images. Figure 3.15 displays the LWIR image taken by the Tau 2. Figure 3.16 displays the SMWIR image taken by the MATRIX 1024 CORE-S.
The third set of images is a combination of the first two sets. The third set was taken with the VWR hotplate set to the high temperature setting (approximately 400°C), and the target objects were a stainless steel nut attached to a bolt as well as two nuts side-by-side directly below the nut and bolt. The two nuts side-by-side were allowed to heat to near the hotplate temperature. The nut and bolt were placed on the hotplate just before the images were taken.
Figure 3.17 shows the top-down image of the object taken by a visible light camera to provide a reference to the infrared images. Figure 3.18 displays the LWIR image taken by the Tau 2. Figure 3.19 displays the SMWIR image taken by the MATRIX 1024 CORE-S.

![Figure 3.17. Image Set #3 – Visible Light Image](image1)

![Figure 3.18. Image Set #3 - LWIR Image](image2)
Figure 3.19. Image Set #3 - SMWIR Image
4. DWT BASED FUSION OF THREE SETS OF INFRARED IMAGES

4.1 Registration and Fusion of Image Set #1

In order to use image fusion techniques, image registration is needed to align the target object in the same spot of the pixel array for both the LWIR and SMWIR images. Both the LWIR and SMWIR images are also required to be of the same size. In our study, the LWIR images were scaled down, and the SMWIR images were scaled up slightly so that both of images have a resolution of 60x60. The control point mapping registration method was chosen to align the individual images of each of the three image sets [8]. During registration, four points are selected in the LWIR image that correspond directly to another set of four points in the SMWIR image. The coordinates of the points in the LWIR image are designated as \((x_1, y_1), (x_2, y_2), (x_3, y_3), (x_4, y_4)\); and the coordinates of the points in the SMWIR are designated as \((x'_1, y'_1), (x'_2, y'_2), (x'_3, y'_3), (x'_4, y'_4)\). Equation 4.1 illustrates the calculation of the transformation matrix that is generated and utilized by Matlab functions to perform the necessary transformations to align the images [5].

\[
TM = \begin{bmatrix} x_1 & x_2 & x_3 & x_4 \\ y_1 & y_2 & y_3 & y_4 \end{bmatrix} \times \begin{bmatrix} x'_1 & x'_2 & x'_3 & x'_4 \\ y'_1 & y'_2 & y'_3 & y'_4 \\ 1 & 1 & 1 & 1 \\ 1 & 1 & 1 & 1 \end{bmatrix}^{-1}
\] (4.1)

Appendix B contains the Matlab codes for implementing the control point mapping registration method to align the individual images of each of the three image sets [8]. After control point mapping registration is applied to the image sets acquired from the physical experiment, image level fusion utilizing DWT is performed to obtain the fused image of each of three sets. Appendix A contains a Matlab program for implementing DWT based image fusion.
method. The control point mapping registration and DWT based fusion were used for the first set of LWIR and SMWIR images. The results are displayed in Figures 4.1-4.4.

The first set of images reveals the advantage of LWIR camera cores over SMWIR cores. The target object was not allowed to be heated up to the hotplate temperature, therefore the temperature difference between the target object and the background (VWR hotplate), was substantial. The thermal detector based Tau 2 recorded an image in which the target object outline was crisp and relatively clear. The SMWIR core produced a much lower quality image. The result of image fusion between the two IR images is visibly higher quality than the SMWIR image as expected.

Another way to perform DWT based image fusion is through Matlab’s Wavelet Toolbox. By typing the Matlab prompt “wavemenu,” the image fusion graphical interface can be accessed. The interface allows a user to load two images, select the desired wavelet, and perform image fusion to create a synthesized image. Image fusion method parameters for the approximation and details of the synthesized image, colormaps, and brightness may also be easily altered within the interface. Figure 4.5 displays the fused image from the first set of images using Matlab’s image fusion graphical interface. In comparison to the fused image in Figure 4.4, the fused image from Matlab’s interface is slightly higher quality. The edges of the target object are sharper and more defined than the previous image. Due to the ease of operation and high quality results, the Matlab graphical interface is used for the next two sets of images instead of the algorithm listed in Appendix B. Detailed operational steps of Matlab’s interface can be found in Appendix D.

Principal component analysis (PCA) is another method by which image fusion may be performed. Appendix C contains an algorithm written in Matlab to perform this type of image fusion. The results of the PCA method were compared to DWT based fusion, and both methods
produced similar results. The PCA method was used in this experiment to simply validate the results of DWT based fusion.

![Figure 4.1. Image Set #1 – Visible Light Image](image1)

![Figure 4.2. Image Set #1 - LWIR Image After Registration](image2)

![Figure 4.3. Image Set #1 – SMWIR Image After Registration](image3)

![Figure 4.4. Image Set #1 – Fused IR Image](image4)

![Figure 4.5. Image Set #1 – Fused IR Image by Matlab GUI](image5)
4.2 Registration and Fusion of Image Set #2

The algorithm including control point mapping as the first step and DWT based image fusion as the second step was implemented on the second image set. The second set of images reveals the advantage of the SMWIR camera core over the LWIR core. The target objects were allowed to heat up to a temperature close to that of the hotplate. Figure 4.7 displays the LWIR image result after image registration. Due to the similar temperature of the target objects and the hotplate background, minimal temperature difference exists between the two which drastically decreases the image quality of the LWIR core. The SMWIR image after image registration as shown in Figure 4.8 still retains a good outline of the target objects despite the low temperature difference. The result of image fusion has been shown in Figure 4.9. Visually, the fused image has higher quality than the LWIR image as expected. The circular detail of each nut that is lost in the LWIR image is picked up by the SMWIR image in the fused image. The result of this second set of images focuses on the advantage that the MATRIX 1024 CORE-S holds over the Tau 2 when temperature differences between the target objects and background are minimal.
4.3 Registration and Fusion of Image Set #3

The experiment design for the third set of images was a hybrid between the first two sets. The goal for this image set was to take the advantages of both LWIR and SMWIR cores as seen in the first two sets of images and combine them in one scenario. Figure 4.11 displays the LWIR image after image registration. The two stainless steel nuts in the lower half of the image lack much detail and definitive outline due to low temperature difference with the background. The nut with the bolt in the same image contains much more detail due to the higher temperature difference. The SMWIR image after registration is shown in Figure 4.12 has a much better outline of the two nuts. After control point mapping registration, the DWT based image fusion
method in the Matlab GUI was implemented on this image set. The fused image result as shown in Figure 4.13 merges the advantages of both camera cores by incorporating the detail of the nut and bolt from the LWIR image and the detail of the two nuts from the SMWIR image. The fused image in this case is visually higher quality than both the original LWIR and SMWIR images.
5. CONCLUSION

The research in this thesis shows that the image quality of two individual infrared camera cores can be improved by performing image fusion on the outputs of the cameras to produce a fused result that has overall higher quality. Three sets of infrared images were gathered using both a LWIR camera and a SMWIR camera during the course of this experiment. Calibration and data acquisition of each core were properly addressed to ensure proper operation of the cores. Control point mapping registration was used with respect to the reference frame to align the separate images within each set of images in order to prepare the images for DWT based fusion. The first set of images highlighted the advantages of the LWIR core. Due to the higher temperature difference between the target object and background of the image, the LWIR core was capable of producing a higher quality image than the SMWIR core; therefore, the result of image fusion was a fused image that improved the quality of the SMWIR image. The second set of images displayed the advantages of the SMWIR core. The photon detectors of the SMWIR core were still able to record the target objects despite a minimal temperature difference between the objects and the background. The result of image fusion in this set was a fused image with higher quality than the LWIR image. The final set of images underscored the functionality of both cores. This set combined the target objects of each of the first two sets, and the application of image fusion resulted in a fused image that was higher quality than both the LWIR and SMWIR images. The overall results of this thesis provide an effective way of improving the quality of infrared cameras through the use of advanced image processing and fusion techniques and strongly support the idea of the proposed low cost, multispectral infrared camera system based on SiGeSn photon detectors and micro-bolometers for high quality images.
REFERENCES


APPENDIX

A. MATLAB Source Code – DWT Algorithm

%% Multispectral Image Fusion Algorithm REV1
%%
%% *Author* : Rocky Hedrick
%%
%% *Date* : 10/18/14
%%
%% *Comments* : The algorithm generated in this script file utilizes the
%% technique for image level fusion as presented in "Hierarchical Fusion of
%% Multi Spectral Face Images of Recognition Performance" by Singh, Vatsa,
%% and Noore from West Virginia University. Sample visual and IR images used
%% to generate fused images were obtained from the OTCBVS Benchmark Dataset
%% Collection (Dataset 03: OSU Color-Thermal Database). The collection is
%% currently managed by Dr. Guoliang Fan at Oklahoma State University.
%% URL: http://www.vcipl.okstate.edu/otcbvs/bench/

clear;
clc;
clear figures;

% Create new matrix X with visual image values. Use mat2gray to transform
% pixel values into the range of (0,1).
X = imread('LW_EXP2_ALIGNED.bmp');
I_V = mat2gray(X);

% Utilize the dwt2 to obtain the wavelet bands of the visual image. Plot each
% wavelet band on the same figure.
[LL_V,LH_V,HL_V,HH_V] = dwt2(I_V,'db1');
figure(1)
subplot(2,2,1);imshow(LL_V);title('Visual Image - LL band');
subplot(2,2,2);imshow(LH_V);title('Visual Image - LH band');
subplot(2,2,3);imshow(HL_V);title('Visual Image - HL band');
subplot(2,2,4);imshow(HH_V);title('Visual Image - HH band');

% Repeat the process for the infrared image.
Y = imread('SMW_EXP2_ALIGNED.bmp');

I_IR = mat2gray(Y);

% Utilize the dwt2 to obtain the wavelet bands of the IR image. Plot each
% wavelet band on the same figure.
[LL_IR,LH_IR,HL_IR,HH_IR] = dwt2(I_IR,'db1');
figure(2)
subplot(2,2,1);imshow(LL_IR);title('IR Image - LL band');
subplot(2,2,2);imshow(LH_IR);title('IR Image - LH band');
subplot(2,2,3);imshow(HL_IR);title('IR Image - HL band');
subplot(2,2,4);imshow(HH_IR);title('IR Image - HH band');

% Take the average of LL band for both IR and visual images to generate
% the fused LL band.
\[
I_{LL \_F} = (LL \_V + LL \_IR) \times 0.5;
\]

% Subdivide each band into windows of 2x2 to generate binary decision maps. % Compare the sums of the absolute values of each window for both visual % and IR images. The new fused band will take the values for whichever % sum value is greater. Utilize the mat2cell function to generate 2x2 % windows. Cell2mat is used to convert back to a matrix of the original % size.

% LH Band Fusion

LH \_V \_DIV =
mat2cell(LH \_V, [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2], [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
LH \_IR \_DIV =
mat2cell(LH \_IR, [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2], [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
k=1;
j=1;
DM \_LH=zeros(15,15);
I \_LH \_F \_DIV=LH \_V \_DIV;
while \ k<16
    while \ j<16
        Z1=sumabs(LH \_V \_DIV\{j,k\});
        Z2=sumabs(LH \_IR \_DIV\{j,k\});
        if \ Z1>=Z2
            DM \_LH(j,k)=1;
            I \_LH \_F \_DIV\{j,k\}=LH \_V \_DIV\{j,k\};
        else
            DM \_LH(j,k)=0;
            I \_LH \_F \_DIV\{j,k\}=LH \_IR \_DIV\{j,k\};
        end
        j=j+1;
    end
    k=k+1;
end
I \_LH \_F=cell2mat(I \_LH \_F \_DIV);

% HL Band Fusion

HL \_V \_DIV =
mat2cell(HL \_V, [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2], [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
HL \_IR \_DIV =
mat2cell(HL \_IR, [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2], [2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
k=1;
j=1;
DM \_HL=zeros(15,15);
I \_HL \_F \_DIV=HL \_V \_DIV;
while \ k<16
    while \ j<16
        Z1=sumabs(HL \_V \_DIV\{j,k\});
        Z2=sumabs(HL \_IR \_DIV\{j,k\});
        if \ Z1>=Z2
            DM \_HL(j,k)=1;
            I \_HL \_F \_DIV\{j,k\}=HL \_V \_DIV\{j,k\};
        else
            DM \_HL(j,k)=0;
            I \_HL \_F \_DIV\{j,k\}=HL \_IR \_DIV\{j,k\};
        end
        j=j+1;
    end
    k=k+1;
end
I \_HL \_F=cell2mat(I \_HL \_F \_DIV);
else
    DM_HL(j,k)=0;
    I_HL_F_DIV(j,k)=HL_IR_DIV(j,k);
end
j=j+1;
end
k=k+1;
j=1;
end
I_HL_F=cell2mat(I_HL_F_DIV);

% HH Band Fusion
HH_V_DIV =
mat2cell(HH_V,[2,2,2,2,2,2,2,2,2,2,2,2,2,2,2],
[2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
HH_IR_DIV =
mat2cell(HH_IR,[2,2,2,2,2,2,2,2,2,2,2,2,2,2,2],
[2,2,2,2,2,2,2,2,2,2,2,2,2,2,2]);
k=1;
j=1;
DM_HH=zeros(15,15);
I_HH_F_DIV=HH_V_DIV;
while k<16
    while j<16
        Z1=sumabs(HH_V_DIV{j,k});
        Z2=sumabs(HH_IR_DIV{j,k});
        if Z1>=Z2
            DM_HH(j,k)=1;
            I_HH_F_DIV(j,k)=HH_V_DIV(j,k);
        else
            DM_HH(j,k)=0;
            I_HH_F_DIV(j,k)=HH_IR_DIV(j,k);
        end
        j=j+1;
    end
    k=k+1;
    j=1;
end
I_HH_F=cell2mat(I_HH_F_DIV);

% Perform inverse DWT on the new fused bands to obtained a final fused % image.
I_F = idwt2(I_LL_F,I_LH_F,I_HL_F,I_HH_F,'db1');

% Plot the original visual image and IR image to compare to the new fused % image.
figure(3)
subplot(2,2,1);imshow(I_V);title('LW IR Image');
subplot(2,2,2);imshow(I_IR);title('SMW IR Image');
subplot(2,2,3);imshow(I_F);title('Fused SMW and LW IR Image');
B. MATLAB Source Code – Control Point Mapping Registration

%% Point Mapping Image Registration
%%
%% *Author* : Rocky Hedrick
%%
%% *Date* : 2/26/15
%%
%% *Comments* : Code was written based on the method described in Matlab's documentation center. URL: http://www.mathworks.com/help/images/register-an-aerial-photograph-to-a-digital-orthophoto.html

clear;
clc;
close all;
clear figures;

fixed = imread('LW_EXP2.bmp');
figure, imshow(fixed)
unregistered = imread('SMW_EXP2+.bmp');
figure, imshow(unregistered)


cpselect(unregistered, fixed)

%% Perform transformations once the control points have been selected using the cpselet function.
mytform = fitgeotrans(movingPoints, fixedPoints, 'projective');
Rfixed = imref2d(size(fixed));
registered = imwarp(unregistered,mytform,'OutputView',Rfixed);
figure, imshowpair(fixed,registered,'blend')

%% Scale images to the desired sizes.
I=imcrop(registered,[42 38 59 59])
I2=imcrop(fixed,[42 38 59 59])
I3=rgb2gray(I2)
C. MATLAB Source Code – PCA Algorithm

%% PCA Image Fusion Algorithm
%
% *Comments* : The algorithm generated in this script file was written
% using a source from Matlab’s File Exchange website. Lines 24–31 were
% written
% by VPS Naidu (HTML: http://www.mathworks.com/matlabcentral/fileexchange/
% 31338-pca-based-image-fusion).

clear;
clc;
clear figures;

X = imread('image1.bmp');
X1 = X(:,:,3);
I_V = mat2gray(X1);

Y = imread('image2.bmp');
Y1 = Y(:,:,3);
I_IR = mat2gray(Y1);

im1=I_V;
im2=I_IR;

% Portion of code obtained from outside source
C = cov([im1(:) im2(:)]);
[V, D] = eig(C);
if D(1,1) >= D(2,2)
   pca = V(:,1)./sum(V(:,1));
else
   pca = V(:,2)./sum(V(:,2));
end
imf = pca(1)*im1 + pca(2)*im2;

% Plot the original visual image and IR image to compare to the new fused
% image.
figure(3)
subplot(2,2,1);imshow(im1);title('Visual Image');
subplot(2,2,2);imshow(im2);title('IR Image');
subplot(2,2,3);imshow(imf);title('Fused Visual and IR Image');
D. MATLAB Wavelet Toolbox – Image Fusion GUI

The following information provided below describes in detail the step-by-step process of using the Wavelet Toolbox in Matlab to perform image fusion via the graphical user interface (GUI). The data used in this description is from the first set of images as seen in section 4.1.

1. Type “wavemenu” into the Matlab command window.
2. The Wavelet Toolbox Main Menu window will open. Select “Image Fusion” under “Specialized Tools 2-D.”

3. The Image Fusion GUI will open. Perform the following file path to load the two images desired for image fusion: File→Load or Import Image 1→Load Image. For wavelet selection, the Daubechies 2 wavelet (db2) with 5th level decomposition was used. For the fusion method parameters, “mean” approximation and “max” details were selected. The
The colormap was changed to “gray.” Press the “Decompose” button and “Apply” once the parameters have all been adjusted. The result will be displayed as seen below.

4. Perform the following file path to save the fused image: File→Save Synthesized Image. Select the desired file location, title, and format. Bitmap (BMP) files were used consistently through the experiments as the file format for the images.

The fusion method parameters can alter the image fusion results. For the first set of images, the “mean” approximation and “max” details provided the best result. “Mean” approximation
represents an average of the pixel values used for the approximation, or LL, subband. “Max” details interpret the pixel values and use the highest values for the detail subbands. For the second and third sets of images, “min” approximation and “max” details provided the best results.